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This page shows the original publication date. The information contained in this publication is subject to 
change without notice. Any improvements or changes to either the product or the book will be 
documented in subsequent updates. 

This publication contains proprietary information which is protected by copyright. All rights are reserved. 
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electronic or mechanical, or translated into another language, without the prior written consent of Deltek, 
Inc. 

This edition published January 2008. 
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Unpublished-rights reserved under the copyright laws of the United States. 

This software is protected by copyright law and constitutes valuable confidential and proprietary 
information of Deltek, Inc. and its licensors. This software, and all related documentation, is provided for 
use only in accordance with the terms of your license agreement. Unauthorized reproduction or 
distribution of this program or any portion thereof could result in severe civil or criminal penalties. 

Notice - This software is 'commercial computer software' as defined in DFARS 252.227-7014 and FAR 
12.212 and software documentation is commercial 'technical data' as defined in DFARS 252.227-7015 
and FAR 12.211. All use, modification, reproduction, release, performance, display, or disclosure of this 
commercial software shall be in strict accordance with the manufacturer's standard commercial license, 
which is attached to and incorporated in the governing Government contract. Manufacturer is Deltek, Inc., 
13880 Dulles Corner Lane, Herndon, VA 20171. 

If this software and documentation has been licensed to the U.S. Government, it is unpublished 
“restricted computer software” as that term is used in FAR Part 27.4, in which Deltek, Inc. has reserved all 
rights under the copyright laws of the United States. 

All other trademarks mentioned herein are the property of their respective owners. 
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If you forget your 
password, go to https:// 
support.deltek.com, 
enter your user ID in 
the If you have 
forgotten your 
password section, and 
click Email Me My 
Password. If you don’t 
have an account at the 
e-Support site, the 
Deltek support contact 
manager at your 
company can log on to 
the e-Support site and 
add users. 

 

 

 

Overview 

In addition to the information and contacts contained in these release notes, 
various other sources of information are available, as described below. 

Many of these services involve accessing Deltek’s e-Support site, which requires 
that your firm have a Deltek Ongoing Support Plan (OSP). Please contact your 
Account Manager for more information. 

Deltek Sema4 Help 

Deltek Sema4 includes an Online Help system. From the Help menu, select 
User’s Guide. You can also access the User’s Guide from the Start menu by 
selecting Programs » Deltek Sema4 » User Guide. 

Deltek Telephone Support 

If you have questions about Sema4 or need application assistance, call Deltek 
Sema4 Support at 877.457.7765. Our experienced support analysts are available 
to take your calls Monday thru Friday between 9:00 AM and 8:00 PM (EST). 

You will find our staff well prepared to handle the everyday operating issues of 
Sema4 users. 

You can leave a message on our voice mail system 24 hours a day. 

Deltek E-Support Site 

To access the Deltek e-Support site: 

1. Open your Internet browser, and go to https://support.deltek.com to log on to 
your company's portal. 

2. Enter your user ID and password. 

3. Click Login. 

An OSP entitles you to access Deltek’s e-Support Web site. With an assigned 
username and password, you can access the following options at the e-Support 
site: 

Support Home Page — View alerts from here. You can also select the 
Knowledge Center, Ask Support, Live Support Chat, or My Stuff links to open 
other e-Support pages, or instead, click the corresponding tab. 

Knowledge Center — From the Knowledge Center tab you can: 
• Search the Support Knowledge Base for solutions to issues and 

questions. New solutions are added each day. The Knowledge Base is 
available 24 hours a day. 

• View or save to your workstation Deltek product information such as 
release notes, user guides, technical information, or white papers (in PDF 
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format). 

• Read information and follow links to third-party software downloads, 
Deltek forms, and third-party vendor forms. 

On the Knowledge Center tab, enter a product, and then select an option from the 
Category field to select a specific area to search—the Knowledge Base, release 
notes, technical information, reference materials, etc. For any item you retrieve on 
the Knowledge Center tab, you have the option to be notified by email if the item 
is updated in the future. 

Ask Support — Submit a question directly to the Support queue for a reply from 
our Support staff. As you type your question, possible related answers from the 
Knowledge Base are provided for your review before you submit your question. 
You can also attach pertinent documentation to your question. 

Live Help — Chat with a support technician on-line. 

My Stuff — From the My Stuff tab, you have the following options: 

• Case History — Check the status of your questions in the Support queue 
or provide additional information for your questions in the queue. 

• My Knowledge Base Items — If you have subscribed to be notified of 
future changes to an item from the Knowledge Center tab, check for any 
updates to those items here. You will also be notified by email of any 
changes. 

• Account Profile — Update your account profile to set new preferences 
or reflect changes to your contact information. 

• Contact Management — Add new contacts from your firm so they can 
access the Deltek e-Support site. This link appears only if you are a 
Deltek support contact manager at your company. 

• Change Password — Change your e-Support password. 

• Events — View Deltek news and events. 

• Usergroups — View usergroup information. 

• Training — Obtain training information. 

• My Files — Upload your files to Deltek if necessary. 

Provide Feedback — Use this option from the Support home page to submit 
comments, suggestions, or opinions about this site to Deltek. 

E-Mail Service 

You can contact Deltek Sema4 Support by email at Sema4Support@deltek.com. 

E-Fax Service 

Users can fax support questions to Deltek Sema4 Support at 503.598.8802. 
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Chapter 1: How to Use These Release Notes 

 

 

To review new features 
and software issues 
resolved in previous 
releases, you can find 
copies of the 8.x and 
9.x release notes at the 
Deltek e-Support site: 
https://support.deltek.c
om. 

The Sema4 9.1 (SP3) update includes payroll tax changes that were not yet 
available for the Sema4 9.1 SP2 YE release in December 2007. It also includes 
one software issue that was resolved. 

 
IMPORTANT INSTALLATION CHANGE: 

If you are upgrading from a Sema4 9.0 version, the Sema4 9.1 (SP3) installation 
overwrites and upgrade your Sema4 9.0 software. It does not install Sema4 9.1 
(SP3) in addition to your previous Sema4 9.0 version, so it is important that you 
make a full backup of your Sema4 9.0 folder (data, report, and program files) 
before you install Sema4 9.1 (SP3). For more information on backing up, see 
Appendix A: Sema4 Backup Procedures. 

 

The following table provides more information about each of the remaining 
chapters in these release notes. 

Chapter Contents 

Chapter 2: New Features 
and Enhancements in 
Sema4 9.1 (SP3) 

Describes software enhancements and new 
features included in Sema4 9.1 (SP3). 

The information is organized according to the 
Sema4 main menu options. 

Chapter 3: Software 
Issues Resolved in 
Sema4 9.1 (SP3) 

Describes software issues resolved in Sema4 9.1 
(SP3). 

The information is organized according to the 
Sema4 main menu options. 

Chapter 4: Operating 
System and Hardware 
Requirements for 
Sema4 9.1 (SP3) 

Lists operating system and hardware 
requirements for running Sema4 9.1 (SP3). 

The operating system and hardware 
requirements did not change between the 9.0 and 
9.1 versions. 

Chapter 5: Upgrading 
from Sema4 9.1 

Provides installation instructions for users 
upgrading from Sema4 9.1 versions (SP1 or SP2 
YE). You install Sema4 9.1 (SP3) on your server 
only. 

 

Chapter 6: Upgrading 
from Sema4 9.0 

Provides installation instructions for users 
upgrading from Sema4 9.0 versions (SP1, SP2, 
SP3, SP4, SP5, SP6 or SP7). 

• Install Sema4 9.1 (SP3) on a network 
server. 

• Install the new Web Timekeeper reports if 
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you use Web Timekeeper. 

• Install Sema4 9.1 (SP3) on individual 
workstations. 

Chapter 7: Upgrading 
from Sema4 8.x 

Provides installation instructions for users 
upgrading from an 8.x version of Sema4, 
including the Web Timekeeper upgrade if you 
currently use Web Timekeeper. 

Chapter 8: Upgrade 
from Sema4 8.x — New 
Web Timekeeper 
Installation 

If you currently use Sema4 8.x and you are 
upgrading to 9.1 (SP3) and installing Web 
Timekeeper for the first time, after you complete 
the steps in Chapter 7 to upgrade Sema4, 
complete the steps in Chapter 8 to install Web 
Timekeeper.  

Chapter 9: Upgrading 
from a Sema4 9.1 
version on a Novell 
Network 

Provides installation instructions for users 
upgrading from a Sema4 9.1 version (SP1 or SP2 
YE) who use a Novell network. 

Chapter 10: Upgrading 
from a Sema4 9.0 
Version on a Novell 
Network 

Provides installation instructions for users 
upgrading from Sema4 9.0 versions (SP1, SP2, 
SP3, SP4, SP5, SP6 or SP7) who use a Novell 
network. 

Chapter 11: Upgrading 
from a Sema4 8.x 
version on a Novell 
Network 

Provides installation instructions for users 
upgrading from a Sema4 8.x version who use a 
Novell network. 

Appendix A: Backing up 
Sema4 

Identifies the Sema4 folders you need to back up 
and how often to back up. 

Appendix B: Preparing 
your current database 
for upgrading 

Provides steps to prepare your current database 
using the Rebuild Sema4 Database Container 
utility. 

Appendix C: Update to 
Remote Entries in 
Sema4 9.1 (SP(SP3) 

Instructs on how to update remote entries in 
Sema4 9.1 (SP3) if you upgraded from Sema4 
8.x or 9.0. 

Appendix D: Assigning 
File Rights and 
Permissions  

Provides instructions for assigning file rights and 
permissions for Windows. 

Appendix E: Assign File 
Rights and Permissions 
When Using a Novell 
Network 

Provides instructions for assigning file rights and 
permissions when using a Novell network. 

Appendix F: Initializing 
your Sema4 License 

Provides instructions for initializing your Sema4 
license if you are installing Sema4 for the first 
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time or you have just upgraded your license. 

Appendix G: Web 
Timekeeper — "Error: 
Access is Denied" 

Provides instructions on how to eliminate this 
error when accessing Web Timekeeper after 
installing the upgrade. 

Appendix H: Sema4 9.1 
(SP3) Web Timekeeper 
Grid Reports 

Provides steps to replace the existing Web 
Timekeeper reports with the optional grid reports 
described in Chapter 2. 

 
 

 

 

The release notes 
documents have 
extensions of “PDF” 
indicating the file type. 

 

 

 

 

 

There are three 
methods you can use 
in Adobe to search a 
document. 

Searching in a PDF 

These release notes are in Adobe PDF format for optimum viewing. You can 
display them on your computer screen or print them. When you display them, you 
can quickly search for the section, enhancement, or other information you want to 
view. 

To search for a particular item or section using the Adobe 
Search function: 
 
1. Open the release notes PDF file by double-clicking the file. 

2. Select the search function in Adobe using any of the following three methods: 

 Click the  icon. 

 Press CTRL+ F. 

 Select Edit » Search. The following window displays: 

 
 
 3. Enter the word or phrase for which to search and click Search. For example, 

to go directly to Chapter 4 you could enter “Chapter 4,” “New Software 
Features,” or “Enhancements.” You could also search by a field name, tab 
name, application, etc. 
 
All occurrences of the search words you entered that are found in this PDF 
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 Chapter 1: How to Use These Release Notes 

are listed. 

4. Click any of the items listed to view the page on which it was found. 

5. Click the correct result (the result you would like to go to). 

 
Other Search Methods: 

 

In addition to searching 
for keywords, you can 
proceed directly to a 
desired section using 
the Contents page or 
the Bookmarks tab. 

• From the Contents page — You can quickly go to a section from the 
Contents page. To do this, simply click any entry on the Contents page to 
proceed directly to that section. 

• From the Bookmarks tab — You can click the Bookmarks tab in the left 
pane to display the bookmarks set in place for this document. Bookmarks 
usually follow the structure of the Table of Contents. Click any bookmark to 
proceed directly to that section. 
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Chapter 2: New Features and Enhancements in Sema4 9.1 
(SP3) 

 Below is a summary of the new software features and enhancements added 
between Sema4 Version 9.1 SP2 YE and Sema4 Version 9.1 (SP3). 

Payroll 
Payroll Tax Tables 

The following tax tables have been updated: 

• Colorado 

Withholding tables did not change for 2008, but Deltek changed the state 
exemption amount from $3,400.00 to $3,500.00 to match the federal 
amount. Colorado accepts either amount. 

http://www.revenue.state.co.us/pdf/drp1098.pdf 

File Updated: data\payroll.* 

• Connecticut 

Table A and Table B for single filers have been changed. 

http://www.ct.gov/drs/lib/drs/forms/2008withholding/2008_withholding_tax
_tables_w_cover_pg.pdf 

File Updated: Payroll.exe 

• District of Columbia 

• The withholding allowance is now $1,675 (increased from $1,500). 

• Wage brackets were updated. 

http://otr.cfo.dc.gov/otr/frames.asp?doc=/otr/lib/otr/2008_fr-230.pdf 

Files Updated: \data\payroll.* 

• Kentucky 

The Standard deduction is now $2,100 (increased from $2,050). 

http://revenue.ky.gov/business/whtax.htm 

File Updated: data\payroll.* 
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• Maryland 

Two new tables for withholding amounts are provided for each Maryland 
county for tax year 2008. The tables apply to employees based on their 
marital status as follows: 

 Table 1 Table 2 

Marital 
Status 

B — Married Filing Joint 

H — Head of Household 

M — Married* 

S — Single  

E — Married Filing Separately 

O — Dependent 

J — One Spouse with Job* 

 

*Note: The State of Maryland's tax documentation did not include marital 
status M and J, which have been added to the two new Maryland tables 
in Sema4 as indicated in the above list. 

Important: If you have employees located in Maryland, be sure the 
following items for each employee are entered correctly so county 
withholding amounts calculate correctly: 

• Marital Status field on the General tab in Setup » Employee. 

• Table field on the Deductions tab in Setup » Employee » Payroll. 

Enter the appropriate Sema4 deduction table for the employee's 
county from the table below: 

Maryland County Withholding Rate 
Percentage 

Sema4 Deduction 
Table Name 

Allegany 3.05% MD305 

Anne Arundel 2.60% MD260 

Baltimore City 3.05% MD305 

Baltimore County 2.85% MD285 

Calvert 2.80% MD280 

Caroline 2.65% MD265 

Carroll 3.05% MD305 

Cecil 2.80% MD280 

Charles 2.90% MD290 

Dorchester 2.65% MD265 

Frederick  3.00% MD300 

Garrett  2.65% MD265 

Release Notes   11 



Release Notes 

Maryland County Withholding Rate 
Percentage 

Sema4 Deduction 
Table Name 

Harford 3.10% MD310 

Howard 3.20% MD320 

Kent 2.85% MD285 

Montgomery 3.20% MD320 

Prince George's 3.10% MD310 

Queen Anne's 2.85% MD285 

St. Mary's 3.00% MD300 

Somerset  3.15% MD315 

Talbot 2.25% MD225 

Washington 2.80% MD280 

Wicomico 3.10% MD310 

Worcester 1.25% MD125 

Nonresidents 1.25% MDNR 

Del 

(Maryland resident 
employees who 
work in Delaware) 

0% MDDEL 

 
 Note 

Withholding rates for Maryland counties are documented at the Maryland 
State Web page listed below. This page displays each county's rate with 
four decimals. Click the link for each county to view the exact percentage 
rate used (rounded or not) for each county. The exact rate is the rate 
Sema4 uses, which is listed in the above table in these release notes. 

http://business.marylandtaxes.com/taxinfo/withholding/2008ptables.asp. 

Files Updated: data\payroll.*, payroll.exe 

• Massachusetts 

• The Standard deduction has changed to $3,400 (up from $3,125 in 
2007). 

• Additional Exemption for Head of Household has increased to $2,400 
(up from $2,250 in 2007). 

http://www.mass.gov/Ador/docs/dor/Forms/Wage_Rpt/PDFs/circ_m08.pdf 
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File(s) Updated: data\payroll.*, payroll.exe 

• Missouri 

Standard deductions have been changed as follows: 

 Single (Married Status: S) — It increased to $5,450. Previously, it 
was $5,350. 

 Married and spouse works (Married Status: M) — It increased to 
$5,450. Previously, it was $5,350. 

 Married and spouse does not work (Married Status: J) — It increased 
to $10,900. Previously, it was $10,700. 

 Head of Household (Married Status: H) — It increased to $8,000. 
Previously it was $7,850. 

http://dor.mo.gov/tax/business/withhold/forms/2008/4282.pdf 

File Updated: Payroll.exe 

• Oklahoma 

Wage brackets were updated to 5.50% (a decrease in top rate from 
5.65%). 

http://www.tax.ok.gov/publicat/08whpkt.pdf 

File Updated: data\payroll.* 

• Rhode Island 

• The Standard allowance is $3,500 for 2008. It was $3,400 in 2007. 

• Wage brackets were updated. 

http://www.tax.state.ri.us/info/08WT.pdf 

Files Updated: \data\payroll.* 

Magnetic Media 

• Georgia 

The following magnetic media items were updated: 

 Added the CR/LF in all records including the end of file after the last 
record (RF). 

 Lines 298–307: Added Other State Data - Period End Date 
(mm/dd/yyyy) last day of the tax year. 

 Lines 331–339: Added the Employer’s State ID as State Control #. 

 Lines 340–482: Added the Employer's Name, Employer's Location 
Address, Employer's Delivery Address, Employer's City, Employer's 
Zip Code, Employer's Zip Code Extension, and Employer's FEIN. 

Updated File(s): w2mediaq.prg, w2.sc* 
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Chapter 3: Software Issues Resolved in Sema4 9.1 (SP3) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Below is a summary of the major software issues that were resolved between 
Sema4 Version 9.1 SP2 YE and Sema4 Version 9.1 (SP3). 

Project Management 
Work in Progress Report (Summarized by Project) 

The detail information in the Work in Progress Summary Report printed as 
double spaced lines of text instead of single spaced lines. It now prints single 
spaced line. 
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Chapter 4: Operating System and Hardware Requirements for 
Sema4 9.1 (SP3) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The operating system and hardware requirements have not changed from Sema4 
9.0, 9.1, or 9.1 (SP1 and SP2 YE) to 9.1 (SP3). 

Operating System and Hardware Requirements 

Operating System Requirements 

One of the following is required, each with the latest service pack: 

 Windows 2000 Professional/Server/Advanced Server 
 Windows Server 2003 Standard/Enterprise 
 Windows XP Professional 

Minimum Hardware Requirements 

 350 Mhz Pentium II processor 
 64 MB of RAM 
 400 MB of hard disk space or the combined size of the \Data folder times 

three, whichever is larger 
 SVGA monitor set to 800x600 or higher resolution 
 Laser printer using the latest PCL 5e printer drivers 

Additional Requirements for Web Timekeeper 

 Web Timekeeper Version 9.1 is only compatible with Sema4 Version 9.1. 
 Internet Information Services (IIS) 5.0 or later. 

Recommended Personal Computer/Workstation Configuration 

 Windows 2000 Professional or Windows XP Professional with the latest 
service pack 

 350 Mhz Pentium II processor 
 128 MB of RAM 
 Minimum 1 gigabyte hard drive 
 Zip drive, tape drive, or CDR-W system for backup 
 CD drive 
 15 inch or larger SVGA monitor 
 Laser printer 
 Microsoft Intellimouse 

Networks Supported 

The following network operating systems are supported: 

 Windows 2000 Professional/Server/Advanced Server with the latest service 
pack 

 Windows 2003 Server with the latest service pack 

Release Notes   15 
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 Windows XP Professional with the latest service pack 
 Novell NetWare Version 6.0 or later using Microsoft Client for Netware 

Networks 

Sema4 9.1 (SP3) is written to take advantage of the power available using 
Pentium processors (including Pentium III and Pentium 4). 

If the minimum requirements specified here are not met, we do not support your 
use of our software. 

Networks that are not on a PC using Windows 2000, Windows 2003, or Windows 
XP, do not use a Pentium processor, or do not have the latest service packs 
installed are not supported. Macintosh or other networks running an emulator or 
PC card of any kind are not supported. 
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Chapter 5: Upgrade from Sema4 9.1 — Installation 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Anti-virus 
software 

 

 

Do you have 
multiple data 
sets? 

 

These installation instructions guide you through using the Check for Sema4 Updates 
routine to upgrade Sema4 9.1, 9.1 (SP1), or 9.1 SP2 YE to Sema4 9.1 (SP3) on your 
server. You do not need to perform any additional installations or setup procedures to 
update Sema4 on your client workstations. 

The installation process consists of the following steps: 

STEP 1 — Prepare your Sema4 9.1 database for updating 

STEP 2 — Back up your Sema4 folder (program, report, and data files) 

STEP 3 — Use the Check for Sema4 Update utility to download the Sema4 9.1 (SP3) 

STEP 4 — Install Sema4 9.1 (SP3) on your network server 

 

Please review all the installation instructions before you begin the software installation. 

 Important Notes 

• Before you install the Sema4 9.1 (SP3) update, you must return all Sema4 
program files and folders (including the Sema4 Data, Rpt, and Keydata 
folders) to their default location (for example in Program Files\Deltek\S490). 
After you install the 9.1 (SP3) update, you can move the three folders back to 
their previous locations. 

• Before you install Sema4 9.1 (SP3), make sure all Sema4 directory and file 
attributes are not marked as read-only or hidden. 

• Close all other programs before you run the Sema4 Setup routine. 

• If you are using anti-virus software, review the documentation from your anti-
virus program on what to do when installing new applications, and take any 
necessary steps. If you are at all unsure of what to do, please disable the 
software until you have completed the installation. 

• After you install the Sema4 update on your server, you must reboot your 
server. 

• If you need to install multiple license data sets for Sema4 9.1 (SP3), please 
contact a Deltek Sema4 support analyst for additional instructions and 
documentation. 

• If you use Web Timekeeper, after you upgrade to Sema4 9.1 (SP3) you will 
receive an "Error: Access is Denied." message when you try to open Web 
Timekeeper. This happens because the IUSR account is overwritten with the 
Deltek Sema4 Local IUSR account during the Sema4 installation. To fix this, 
you must stop Internet Information Services (IIS), reinstate the domain IUSR 
account or reset the password for the local Deltek Sema4 account, and restart 
IIS. For complete instructions, see Appendix G: Web Timekeeper — "Error: 
Access is Denied" 
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Prepare your Sema4 Database for Upgrading 

Before you upgrade to Sema4 9.1 (SP3) on your network server, you must follow the 
steps in Appendix B: Prepare Your Current Sema4 Data for Upgrading. 

 

Back up your Sema4 9.0 Folder 

Be sure to make a full backup of your Sema4 directory with all contents intact. For 
more information on backing up, see Appendix A: Sema4 Backup Procedures. 

 

Download the Sema4 9.1 (SP3) installation file 

1. From the Windows Start menu, select Programs » Deltek Sema4 9.1 » Check 
for Sema4 Updates. 

An Available Software Updates screen displays while it searches for updates. 

2. In the Software Manager screen, select the Deltek 9.1 (SP3) check box. 

3. Click Download Only to download a copy of the installation file 
(DeltekSema491SP3Patch.exe ) to your computer. 

4. In the next Software Manager screen, enter your Deltek e-Support site username 
and password. 

5. When asked to run or save the DeltekSema491SP2.exe file, save it to a location 
on your computer. 

 

Upgrade from Sema4 9.1 to Sema4 9.1 (SP3) on your 
server 

1. From your Sema4 server, use Windows Explorer to navigate to the location of the 
DeltekSema491SP3.exe installation file. 

2. Double-click DeltekSema491SP3.exe to start the installation. 

3. In the message Sema4 - InstallShield Wizard screen that informs you that a 
backup of your data will be made before the upgrade is installed, click OK. 
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While your data is backing up, you see the following message: 

 

4. On the Welcome to the InstallShield Wizard for Sema4 dialog, click Next. 

 
5. On the Ready to Install the Program dialog, click Install. 
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The Setup Status dialog displays while Sema4 is being installed. 

 

 

You see the following screens when the Sema4 Cleanup routine updates your 
database. 

NOTE: If the Cleanup Procedures do not run automatically, please call Sema4 
Support. 
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6. Click the X button in the upper right corner of the S4cleanup screen to proceed to 
the next screen. 

 
 

7. In the Update Complete dialog, click Finish. 

 
 

8. After you install the Sema4 update on your server, reboot your server. 

You have completed your upgrade to Sema4 9.1 (SP3). 
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Chapter 6: Upgrade from Sema4 9.0 — Installation 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 

This section guides you through upgrading to Sema4 9.1 (SP3) if you currently 
have a Sema4 9.0 version installed. 

 

  Note 

Please read all these installation instructions carefully before you begin because 
they are different from previous Sema4 installations. 

 
IMPORTANT INSTALLATION CHANGES: 

 The Sema4 9.1 (SP3) installation overwrites and upgrades your Sema4 9.0 
software. Because it does not install 9.1 (SP3) in addition to your previous 9.0 
software, it is important that you make a full backup of your Sema4 9.0 folder 
(data, report, and program files) before you install Sema4 9.1 (SP3). For more 
information on backing up, see Appendix A: Sema4 Backup Procedures. 

 
 If you currently have Web Timekeeper installed on the same server as your 

Sema4 software, when you install Sema4 9.1 (SP3) on your Sema4 server, it 
automatically upgrades your Web Timekeeper 9.0 version to Web 
Timekeeper 9.1. In addition to this, you must follow another set of instructions 
to install the Sema4 9.1 (SP3) WEBTK.FRX report file. These instructions are 
included in this chapter. 

 
 When you install Web Timekeeper, a new local IUSR account called 

DeltekSema4 is assigned anonymous access in the IIS setup for the TK 
virtual directory. If you installed Web Timekeeper to a webserver separate 
from the server on which the core Sema4 financial program is installed, then 
you need to reassign anonymous access to the domain IUSR account and 
verify that the domain IUSR account has full permissions and full control to 
the Data, Site, and TK folders. 

 
The installation process consists of the following steps: 

STEP 1 — Prepare your Sema4 9.0 database for upgrading 

STEP 2 — Back up your Sema4 9.0 folder (program, report, and data files) 

STEP 3 — Download the Sema4 9.1 (SP3) installation file 

STEP 4 — Install Sema4 9.1 (SP3) on your network server 

STEP 5 — Install new Web Timekeeper reports, if you use Web Timekeeper 

STEP 6 — Perform the steps in Appendix G: Web Timekeeper — "Error: 
Access is Denied" if you use Web Timekeeper 

STEP 7 — Install Sema4 9.1 (SP3) on your client workstations 

STEP 8 — Update to Remote Entries in Sema4 9.1 (SP3) 
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Anti-virus software 

 

 

 

Do you have multiple 
sets of data? 

 Important Notes 

• Before you install the Sema4 9.1 (SP3) update, you must return all 
Sema4 program files and folders (including the Sema4 Data, Rpt, and 
Keydata folders) to their default location (for example in Program 
Files\Deltek\S490). After you install the 9.1 (SP3) update, you can move 
the three folders back to their previous locations. 

• Before you install Sema4 9.1 (SP3), make sure all Sema4 directory and 
file attributes are not marked as read-only or hidden. 

• Close all other programs before you run the Sema4 Setup routine. 

• If you are using anti-virus software, review the documentation from your 
anti-virus program on what to do when installing new applications, and 
take any necessary steps. If you are at all unsure of what to do, please 
disable the software until you have completed the installation. 

• After you install the Sema4 update on your server, you must reboot your 
server. 

• If you need to install multiple license data sets for Sema4 9.1 (SP3), 
please contact a Deltek Sema4 support analyst for additional 
instructions and documentation. 

 
Prepare your Sema4 Database for Upgrading 

Before you upgrade to Sema4 9.1 (SP3) on your network server, you must follow 
the steps in Appendix B: Prepare Your Current Sema4 Data for Upgrading. 

 

Back up your Sema4 9.0 Folder 

Be sure to make a full backup of your Sema4 directory with all contents intact. For 
more information on backing up, see Appendix A: Sema4 Backup Procedures. 

 

Download the Installation File 

To download the Sema4 9.1 (SP3) installation file using the Check for 
Sema4 Updates utility if you currently have Sema4 9.0 version installed: 

 
1. From the Windows Start menu, select Programs » Deltek Sema4 9.1 » 

Check for Sema4 Updates. 

An Available Software Updates screen displays while it searches for 
updates. 

2. In the Software Manager screen, select the Deltek 9.1 (SP3) check box. 

3. Click Download Only to download a copy of the installation file 
(DeltekSema491SP3.exe ) to your computer. 

4. In the next Software Manager screen, enter your Deltek e-Support site 
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username and password. 

5. When asked to run or save the DeltekSema491SP3.exe file, save it to a 
location on your computer. 

 

Install Sema4 9.1 (SP3) on Your Network Server 

If you have a 9.0 version of Sema4 installed, to begin the installation of Sema4 
9.1 (SP3), you must first install Sema4 9.1 (SP3) on your network server. 

Warning: 

The Sema4 9.1 (SP3) installation overwrites and upgrades your Sema4 9.0 
software. Because it does not install Sema4 9.1 (SP3) separately from the 
previous Sema4 9.0 version, it is important that you make a full backup of 
your Sema4 9.0 folder (data, report, and program files) before you install 
Sema4 9.1 (SP3). For more information on backing up, see Appendix A: 
Sema4 Backup Procedures. 

The person installing Sema4 must have full administrative rights to the server as 
well as full rights to the folder where Sema4 will be installed. 

Neither Sema4 nor Remote Time Entry (RTE) are designed to run directly over a 
wide area network. If you use a WAN, such as Citrix Metaframe or Terminal 
Services, attempting to do so can result in data and index corruption. If you have 
any further questions please contact Deltek Sema4 Support. 

 

To install Deltek Sema4 9.1 (SP3) on your network server: 

1. From your Sema4 server, use Windows Explorer to navigate to the location of 
the DeltekSema491SP3.exe installation file. 

2. Double-click DeltekSema491SP3.exe to start the installation. 

3. On the first InstallShield Wizard dialog, you receive a message that your 
Sema4 9.0 version will be automatically backed up to the specified location. 
The backup is important because the installation will upgrade your Sema4 9.0 
version rather than install Sema4 9.1 in addition to your Sema4 9.0 version. 
Click OK to continue. 
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While your data is backing up, you see the following message: 

 

4. On the Welcome dialog, click Next. 

 

5. On the Ready to Install the Program dialog, click Install to start the 
installation. 
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The Setup Status dialog opens, and you see the status of the installation 
progress as the software is installed. 

 
 

In the Sema4 Cleanup Procedure Status dialog you see a check mark in 
each check box as the cleanup item is completed. 

NOTE: If the Cleanup Procedures do not run automatically, please call 
Sema4 Support. 
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6. On the S4cleanup dialog where you see the successful cleanup results, click 
the X button in the upper right to close the dialog. 

 

7. In the Update Complete dialog, click Finish. 

 

 
You have completed the installation of Sema4 9.1 (SP3) on your network server. 
 
You must restart your network server before you can use the updated 
version of Sema4. 
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Install the Sema4 9.1 (SP3) Web Timekeeper Reports 

If you previously had Web Timekeeper 9.0 installed, it was upgraded to Web 
Timekeeper 9.1 (SP3) when you upgraded to Sema4 9.1 (SP3) on your server. 
 
To overwrite and add the fixes to your Sema4 9.1 (SP3) WEBTK.FRX report file 
within the Time Table directories and finish the Web Timekeeper upgrade, 
complete the following steps: 
 
Note: This does not install the optional Web Timekeeper reports that include 
hours and project/phase/task in a grid, which are described in Chapter 2: New 
Features and Enhancements in Sema4 9.1 . To install those reports, after you 
complete the instructions in this section, follow the steps in Appendix H: Sema4 
9.1 (SP3) Optional Web Timesheet Grid Reports. 
 
 
1. Make a full backup of all files in each Sema4 Time Table directory. 

2. Select Windows Start » All Programs » Deltek Sema4 9.1 » Weblink. 

3. In the Sema4 Web Timekeeper Administration Tools dialog, select WebTK 
Administration » Configuration. 

4. In the Configuration Utility dialog, click Edit, and then click Save without 
making any changes to the Site.dbf file. 

5. Be sure to select Ignore All when asked if you want to overwrite the 
Timesheet Data files, which are the site.* files. If your webtk.frx is customized, 
select Ignore, instead. 

 

6. Close the dialog and the Web Timekeeper Administration Tools application. 
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Perform the Steps in Appendix G: Web Timekeeper — 
"Error: Access is Denied" if you use Web Timekeeper 

If you use Web Timekeeper, after you upgrade to Sema4 9.1 (SP3) you will 
receive an "Error: Access is Denied." message when you try to open Web 
Timekeeper. This happens because the IUSR account is overwritten with the 
Deltek Sema4 Local IUSR account during the Sema4 installation. To fix this, you 
must stop Internet Information Services (IIS), reinstate the domain IUSR account 
or reset the password for Deltek Sema4, and restart IIS. For complete 
instructions, see Appendix G: Web Timekeeper — "Error: Access is Denied" 

 

 

 

Because Help and 
documentation have 
been updated, you 
MUST run the 
workstation setup for 
all users. 

 

Install Sema4 9.1 (SP3) on Your Client Workstations 

When you upgrade from a Sema4 9.0 version, after you install Sema4 9.1 (SP3) 
on your network server, you must install the application or selected client 
components on each client workstation that will run Sema4. 

If you are using anti-virus software, review the documentation from your anti-virus 
program on what to do when installing new applications, and take any necessary 
steps. If you are at all unsure of what to do, please disable the software on a 
workstation until you have completed the installation. 

If you need to install multiple data sets for Sema4 9.1 (SP3), please contact 
Deltek Sema4 Support for additional instructions and documentation. 

To install Deltek Sema4 9.1 (SP3) on a client workstation: 

From the client workstation, use Windows Explorer to navigate to the network 
share created during the server installation (<Server>\S490). 

1. Double-click DeltekSema491Client.exe to start the installation. 

2. On the Welcome dialog, click Next. 

 



Release Notes 

3. On the License Agreement dialog, read the license agreement, select the I 
accept the terms of the license agreement option, and click Next. 

 

4. On the Start Copying Files dialog, review the information in the Current 
Settings box, and click Next. 
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The Setup Status dialog displays the installation progress. 

 

5. On the Deltek Sema4 Installation Wizard Complete dialog, click Finish. 

 

Please reboot the workstation before you begin using Sema4 9.1 (SP3) on this 
workstation. 

You have completed the installation of Sema4 9.1 (SP3) on this workstation. 

Repeat these steps to install Sema4 9.1 (SP3) on other workstations. 
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Update to Remote Entries in Sema4 9.1 

For instructions on how to update remotes entries from Sema4 9.0 to 9.1 (SP3) 
see Appendix C: Update to Remote Entries in Sema4 9.1. 

32   



 Chapter 7: Upgrade from Sema4 8.x — Installation 

Chapter 7: Upgrade from Sema4 8.x — Installation 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Anti-virus 
software 

 

 

Do you have 
multiple sets of 
data? 

This section guides you through upgrading to Sema4 9.1 (SP3) if you currently have 
a Sema4 8.x version installed. 

The installation process consists of the following steps: 

STEP 1 — Prepare your Sema4 8.4 database for upgrading 

STEP 2 — Back up your Sema4 8.4 folder (program, report, and data files) 

STEP 3 — Web Timekeeper considerations (including site.* file renaming) 

STEP 4 — Download the 9.1 (SP3) installation file 

STEP 5 — Install Sema4 9.1 (SP3) on your network server 

STEP 6 — Run the Update Data Program 

STEP 7 — If you use Web Timekeeper, install Sema4 9.1 (SP3) Web 
Timekeeper reports 

STEP 8 — If you had 8.x Web Timekeeper installed, transfer your 8.x Web TK 
data from the old_site.dbf to the site.dbf 

STEP 9 — Install Sema4 9.1 (SP3) on your client workstations 

STEP 10 — Update Sema4 remote entries 

STEP 11 — Perform the steps in Appendix G: Web Timekeeper — "Error: 
Access is Denied" if you use Web Timekeeper 

 
Please review all of the instructions before you begin your software installation. 

 Important Notes 

• Before you install the Sema4 9.1 (SP3) update, you must return all Sema4 
program files and folders (including the Sema4 Data, Rpt, and Keydata 
folders) to their default location (for example in C:\Program 
Files\Deltek\S484). After you install the 9.1 (SP3) update, you can move the 
three folders back to their previous locations. 

• Before you install Sema4 9.1 (SP3), make sure all Sema4 directory and file 
attributes are not marked as read-only or hidden. 

• Close all other programs before you run the Sema4 Setup routine. 

• If you are using anti-virus software, review the documentation from your 
anti-virus program on what to do when installing new applications, and take 
any necessary steps. If you are at all unsure of what to do, please disable 
the software until you have completed the installation. 

• After you install the Sema4 update on your server, you must reboot your 
server. 

• If you need to install a multiple license data setup for Sema4 9.1 (SP3), 
please contact a Deltek Sema4 support analyst for additional 
instructions and documentation. 
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If you are using a 
customized version 
of Sema4, do not 
install this upgrade 
unless you have 
checked with 
application support. 

 

 

 

 

Prepare your Sema4 Database for Upgrading 

Before you upgrade to Sema4 9.1 (SP3) on your network server, you must follow 
the steps in Appendix B: Prepare Your Current Sema4 Data for Upgrading. 

 

Back up your Sema4 8.x Directory 

Be sure to make a full backup of your Sema4 directory with all contents intact. For 
further information on backing up, see Appendix A: Sema4 Backup Procedures. 

 

Web Timekeeper Considerations 

For Sema4 8.x users who currently have Web Timekeeper 8.x installed: 

Before you start the upgrade process, you must do the following: 

• Make a backup of your Sema4 8.x Time Table/Site folder, and then rename 
all the files in the 8.x Site folder by placing a lower case x in front of each 
file name. 

• Uninstall Web Timekeeper 8.x before you install Sema4 9.1 (SP3) on your 
server. Use the Windows Add or Remove Programs option from the 
Windows Control Panel to remove 8.x Web Timekeeper. 

 
For new Web Timekeeper users: 

If you are a Sema4 8.x user installing Web Timekeeper for the first time, before you 
complete the upgrade instructions in this chapter and install Sema4 9.1 (SP3) on 
your server, please read the complete instructions for installing Web Timekeeper in 
Chapter 8: Upgrade from Sema4 8.x, 9.0 or 9.1 — New Web Timekeeper 
Installation. 

Before you install Sema4 9.1 (SP3) on your server, you must create a Time Table 
folder on your Web server. Sema4 timesheet data files are installed in this folder. 
We recommend that you name the folder SITE. 

 

Download the Sema4 9.1 (SP3) Installation File 

To download the Sema4 9.1 (SP3) installation file from the Deltek e-Support 
site if you currently have a Sema4 8.x version installed: 

 
1. Go to http://support.deltek.com/distribution/DeltekSema4.aspx. 

2. Log on with your e-Support/RNT username and password. 

3. In the Deltek Sema4 Downloads dialog where Sema4 9.1 (SP3) is listed: 

 Click the Deltek Sema4 9.1 (SP3) Release Notes button to download a 
copy of the release notes. 
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 Click the Deltek Sema4 9.1 (SP3) button to download the 
DeltekSema491SP3.exe installation file. 

 

 Install Sema4 9.1 (SP3) on Your Network Server 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To begin the installation process, you must first install Sema4 9.1 (SP3) on your 
network server. The person installing Sema4 must have full administrative rights to 
the server as well as full rights to the folder where Sema4 will be installed. 

Neither Sema4 nor RTE are designed to run directly over a wide area network. If 
you use a WAN, such as Citrix Metaframe or Terminal Services, attempting to do so 
can result in data and index corruption. If you have any further questions please 
contact Deltek Sema4 Support. 

To install Deltek Sema4 9.1 (SP3) on your network server: 

1. From your Sema4 server, use Windows Explorer to navigate to the location of 
the DeltekSema491SP3.exe installation file. 

2. Double-click DeltekSema491SP3.exe to start the installation. 

3. In the Sema4 - InstallShield Wizard dialog, you see a message reminding you 
to run the installation on your Deltek Sema4 9.1 (SP3) server. You cannot install 
Sema4 9.1 via a mapped network drive or UNC path. Click OK to continue. 
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4. On the Welcome dialog, click Next. 

 

5. Read the agreement on the License Agreement dialog, select the I accept the 
terms of the license agreement option, and click Next. 
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6. On the Choose Destination Location dialog, the default location where Sema4 
will be installed is displayed. To change this, click Change, and then select 
another location. Click Next to continue. 

 

7. On the Select Features dialog, select the Sema4 check box and the Web 
Timekeeper check box (if you use it), and click Next. 

Note: 

If you currently have Web Timekeeper 8.x installed, you must uninstall it before 
installing Web Timekeeper 9.1 (SP3). You must also make a backup copy of 
your 8.x Time Table/SITE folder before you install Web Timekeeper 9.1 (SP3). 

If you are a Sema4 8.x user installing Web Timekeeper for the first time, please 
read the full instructions in Chapter 8: Upgrade from Sema4 8.x, 9.0 or 9.1 — 
New Web Timekeeper Installation before you continue with these steps. You 
must create a Time Table/SITE folder on your Web Server before continuing. 
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8. In the Start Copying Files dialog, review the information in the Current Settings 
box, and click Next to start the installation. 

 

 
The Setup Status dialog opens, and you see the installation progress as the 
software is installed. 
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In the Sema4 Cleanup Procedure Status dialog you see a check mark in each 
check box as the cleanup item is completed. 

NOTE: If the Cleanup Procedures do not run automatically, please call Sema4 
Support. 

 

9. On the S4cleanup dialog where you see the successful cleanup results, click 
the X button in the upper right to close the dialog. 

 

10. On the Deltek Sema4 Installation Wizard Complete dialog, click Finish. 

 

11. Restart your server. 

You have completed the installation of Sema4 9.1 on your network server. 
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The Update utility 
first imports your 
data, including your 
Sema4 license, 
invoice designs, 
and report designs. 

Then, based on the 
selections in this 
dialog, it offers to 
replace the pre-
designed invoice 
and report designs 
with the newest 
versions. 

Run the Update Data Program 

1. Select Windows Start » Run. 

2. Browse to the Sema4 Version 9.1 folder, and double-click UPDATE.EXE to 
start the update. 

3. On the Update Sema4 for Windows dialog, complete the following and then 
click OK. 

 

 Select the options for the 8.x old version of Sema4 you are using. 

 The Data directory for Version 9.1 field prefills. 

 Use the  button to find and make a selection in the Data directory for 
old version field. 

 Append 9.1 sample designs for — Select the check boxes for the 
standard designs you want to update. 

We recommend that you select all of them to ensure that your upgrade 
includes all of the new features. If you are concerned that you might 
overwrite customized designs during the upgrade, contact Technical 
Support for assistance. 

A series of messages appears that reads, “Checking Data File..., Recovering 
Data File..., Updating Data File...,” and so on. 

4. When an ID is found in one of your design files that matches one of the sample 
IDs, a dialog box similar to the following opens. 
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The utility offers to place the newest version of the sample design specified in 
your files. In general, you should select Overwrite All in every case. If you have 
changed a standard design without assigning it a new ID, you must select either 
Change ID or Ignore Sample to retain your changes. 

 Ignore Sample — Leaves the existing (old) design in your file, and moves 
on to checking the next ID. 

 Ignore All — Cancels the attempt to add or replace the remaining designs 
in the current file, leaving all of the old designs in place. 

 Overwrite — Replaces the existing (old) design in your file with the new 
sample design. 

 Overwrite All — Replaces all remaining designs in the current file with the 
new sample designs. 

 Change ID — Opens the following dialog, which allows you to copy the 
sample design into your file, assigning it a different ID. 

 

 
 

Install the Sema4 9.1 (SP3) Web Timekeeper Reports 

If you previously had Web Timekeeper 8.x installed, it was upgraded to Web 
Timekeeper 9.1 (SP3) when you upgraded to Sema4 9.1 (SP3) on your server. 
 
To add the Sema4 9.1 (SP3) WEBTK.FRX report file to the Time Table directories 
and finish the Web Timekeeper upgrade, you must complete the steps in this 
section. 
 
Notes: 

 This does not install the optional Web Timekeeper reports that include hours 
and project/phase/task in a grid, which are described in Chapter 2: New 
Features and Enhancements in Sema4 9.1 . To install those reports, after you 
complete the steps in this section, see Appendix H: Sema4 9.1 (SP3) Optional 
Web Timesheet Grid Reports. 

 If you did not previously have Web Timekeeper 8.x installed and you are now 
installing Web Timekeeper for the first time, see Chapter 8: Upgrade from 
Sema4 8.x, 9.0 or 9.1 — New Web Timekeeper Installation. 
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To add the Sema4 9.1 (SP3) WEBTK.FRX report file to the Time Table 
directories and finish the Web Timekeeper upgrade: 
 
1. Make a full backup of all files in each Sema4 Time Table directory. 

2. Select Windows Start » All Programs » Deltek Sema4 9.1 » Weblink. 

3. In the Sema4 Web Timekeeper Administration Tools dialog, select WebTK 
Administration » Configuration. 

4. In the Configuration Utility dialog, click Edit, and then click Save. 

5. Make sure you have renamed your SITE.* files and webtkadm.dbf file before 
proceeding with this step to select Overwrite when asked if you want to 
overwrite the Timesheet Data files. The Timesheet Data files are the site.* files. 
By renaming the files first, they will not be overwritten. You can rename the files 
with an x at the beginning of the file name (xsite.dbf, xsite.cdx, xsite.fpt and 
xwebtkadm.dbf). Weblink will create a new empty database so the old 
timesheet history can be transferred to the new 9.1 site.* files. 

 

6. Close the dialog and the Web Timekeeper Administration Tools application. 

 
 

 

 

 

 

 

 

Transfer your Sema4 8.x Web Timekeeper data if you 
had 8.x Web Timekeeper installed 

If you previously used Sema4 8.x Web Timekeeper and upgraded to Sema4 9.1 
(SP3), you need to transfer timesheet records from your 8.x version to the 9.1 (SP3) 
version. 

You do this from within Sema4 the Financial Management software. 
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1. From the Utilities menu, select Database Tools » Update A Data File. 

2. Click OK in the Warning screen. 

3. In the Update A Date File screen, enter the following, and then click OK: 

Target File — Browse to and select the site.dbf file (you transfer your 8.x 
Timesheet data to this file). 

Source File — Browse to and select the xsite.dbf file that contains your 8.x 
Timesheet data. 

 

4. In the next screen, click OK. 

 

5. Repeat these steps to transfer your calendar information from the 
xwebtkadm.dbf file (old one) to the webtkadmin.dbf file (new one). 

 

 
 

 

 

Because Help and 
documentation 
formats have been 
updated in the 
software, you 
MUST run the 
workstation setup 
for all users. 

 

Install Sema4 9.1 (SP3) on Your Client Workstations 

After you install Sema4 9.1 (SP3) on your network server, assign file rights and 
permissions, initialize your license, and update your data, you must install the 
application (or selected components) on each client workstation that will run Sema4 
(or selected components). 

If you are using anti-virus software, review the documentation from your anti-virus 
program on what to do when installing new applications, and take any necessary 
steps. If you are at all unsure of what to do, please disable the software until you have 
completed the installation. 

If you need to install a multiple license data setup for Sema4 9.1 (SP3), please 
contact Deltek Sema4 Support for additional instructions and documentation. 
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To install Deltek Sema4 9.1 (SP3) on a client workstation: 

1. From the client workstation, use Windows Explorer to navigate to the network 
share created during the server installation (<Your Server>\S490). 

2. Double-click DeltekSema491Client.exe to start the installation. 

3. On the Welcome dialog, click Next. 

 

4. On the License Agreement dialog, read the license agreement, select the I 
accept the terms of the license agreement option, and click Next. 
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5. On the Start Copying Files dialog, review the information in the Current Settings 
box, and click Next. 

 

 
The Setup Status dialog displays the installation progress. 
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6. On the Deltek Sema4 Installation Wizard Complete dialog, click Finish. 

 

Please reboot the workstation before you begin using Sema4 9.1 (SP3) on this 
workstation. 

You have completed the installation of Sema4 9.1 (SP3) on this workstation. 

Repeat these instructions to install Sema4 9.1 (SP3) on other workstations. 

 

Update to Remote Entries in Sema4 9.1 

Please see Appendix C: Update to Remote Entries in Sema4 9.1 for instructions on 
how to update remote entries. 
 

If you use Web Timekeeper, Perform the Steps in 
Appendix G: Web Timekeeper — "Error: Access is 
Denied" 

If you use Web Timekeeper, after you upgrade to Sema4 9.1 (SP3), you will receive 
an "Error: Access is Denied." message when you try to open Web Timekeeper. This 
happens because the IUSR account is overwritten with the Deltek Sema4 Local IUSR 
account during the Sema4 installation. To fix this, you must stop Internet Information 
Services (IIS), reinstate the domain IUSR account or reset the password for the 
Deltek Sema4 account, and restart IIS. For complete instructions, see Appendix G: 
Web Timekeeper — "Error: Access is Denied" 
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Chapter 8: Upgrade from Sema4 8.x, 9.0 or 9.1 — New Web 
Timekeeper Installation 

 

 

 

For additional 
installation and 
configuration 
instructions, see 
the Sema4 Web 
Timekeeper 
Installation 
guide. You can 
download this 
guide from the 
Deltek e-
Support site. 

 

This section contains instructions for Sema4 8.x, 9.0, or 9.1 users who have not used 
Web Timekeeper in the past and are installing Web Timekeeper for the first time when 
upgrading to Sema4 9.1 (SP3). 

Web Server Prerequisites 

 Name-brand, server-class machine 
 Dual Pentium III-800 (QUAD capable) processor 
 1 GB of RAM or more 
 2 9-GB SCSI-2 hard drives 
 RAID controller 
 100 MB Network card (full duplex) 
 Properly sized, uninterrupted power supply 
 Windows 2000 Server (with most current service pack) 
 Internet information Services (IIS) Version 5.0 or later 

Additional Requirements 

 The server(s) that Sema4 is installed on and the Web server that Web Timekeeper 
is installed on must be connected to the same LAN. 

 The Web Timekeeper license must be installed in the Sema4 system(s) that use 
Web Timekeeper. 

 A permanent drive must be mapped from the Web Timekeeper server to the drive 
where Sema4 is installed. UNC does not work. 

 Internet Explorer version 5.0 or later must be installed on the workstations that 
access Web Timekeeper.  

 You must be using Sema4 Version 9.1 to use Web Timekeeper Version 9.1. Web 
Timekeeper Version 9.1 is not compatible with earlier versions of Sema4. 

Installing Web Timekeeper 

The person installing Web Timekeeper must have full administrative rights on the server 
where Web Timekeeper will be installed as well as full rights to the folder where Sema4 
is installed. 

The installation consists of the following steps: 

STEP 1 — Create the Timesheet Data folder 
STEP 2 — Install Web Timekeeper (at the same time you install Sema4) 
STEP 3 — Link Web Timekeeper link to Sema4 
STEP 4 — Set up pay periods for Web Timekeeper 
STEP 5 — Assign permissions for Web Timekeeper 
STEP 6 — Tell users how to connect to Web Timekeeper 
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Create the Timesheet Data Folder 

The folder where Web Timekeeper itself is installed can be created during setup. 
However, before running the setup, you need to create a Time Table folder on the Web 
server. This is where the timesheet data files are installed. We recommend that you 
name the folder \SITE. 

 
Install Web Timekeeper 

If you selected Web Timekeeper on the Installation Wizard Select Features dialog when 
you installed Sema4 9.1 (SP3) on your Sema4 server, then Web Timekeeper has been 
installed in the S490\Web folder. 

If you did not select Web Timekeeper when you installed Sema4 9.1 (SP3) on your 
Sema4 server, you must uninstall Sema4, and reinstall with both Sema4 and Web 
Timekeeper selected for installation. The "Install Sema4 9.1 (SP3) on Your Network 
Server“ instructions are on page 35 of Chapter 7. Web Timekeeper and Sema4 must be 
installed on the same server. 

 
New IUSR Account 

When you install Web Timekeeper, a new local IUSR account called DeltekSema4 is 
assigned anonymous access in the IIS setup for the TK virtual directory. If you installed 
Web Timekeeper to a webserver separate from the server on which the core Sema4 
financial program is installed, then you need to reassign anonymous access to the 
domain IUSR account and verify that the domain IUSR account has full permissions and 
full control to the Data, Site, and TK folders. 

 
Link Web Timekeeper to Sema4 

The Administration Tools screen opens during initial setup or when you run 
WEBS4LINK.EXE (located in the Web Timekeeper, Web folder). 

1. From the WebTK Administration menu, select Configuration. 
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2. On the Configuration Utility dialog, click the Edit button. 

 

3. On the Configuration Utility dialog, set up the connection between Web Timekeeper 
and Sema4. For most users, this means creating one entry on the first line of the 
grid. 

 

 Description — This assigns a name to the timesheet database that each user 
selects when starting Web Timekeeper. If you only use one copy of Sema4, we 
recommend just using Timesheets. If you have multiple copies of Sema4 
tracking time, you need to set up the connection for each, and we recommend 
you use the company name for each company. 

 Lookup Limit — This setting controls how many projects are returned when a 
user asks for a list of projects. A setting of -1 means that the entire list is 
returned at one time. If you have a very large number of active projects, you 
need to try different numbers to see what works best on your system. 

 Sema4 Data Directory — Use the  button to browse to and select the \DATA 
folder for Sema4. This must use a permanently mapped drive letter. 

 Time Table Directory — Use the  button to browse to and select the folder 
that you created before you ran setup (\SITE). Setup automatically places the 
appropriate files in this folder when you save the entry. If you are running more 
than one copy of Sema4, you must create and use a separate folder for each, 
as the actual file names are always the same. 

 Period — Use the  button to specify the frequency of submitted timesheets. 
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4. When you are done, click Save. The file S4DATABASES.XML is created or re-
created in the \DATABASES folder below the main Web Timekeeper folder and the 
appropriate versions of SITE.DBF are copied to the Time Table folder. 

 
Set Up Pay Periods for Web Timekeeper 

The Administration Tools screen opens during initial setup or when you run 
WEBS4LINK.EXE (located in the Web Timekeeper, Web folder). 

1. From the Web TK Administration menu, select Calendar. 

2. On the Calendar for Timesheets dialog, click the Edit button. 

3. On the Calendar for Timesheets dialog, in each line of the grid, define one 
timesheet period that will be available to users. 

 

4. Click Save. 

5. The file S4DATABASES.XML is created or recreated in the \DATABASES folder 
within the main Web Timekeeper folder. The appropriate versions of SITE.DBF are 
copied to the Time Table folder. In addition to the SITE.DBF, the appropriate 
WebTK.FRX are copied to the Time Table folder. 

6. When you finish, from the File menu, select Exit. 

7. During initial setup, there is a final screen from the setup program. Select Finish. 

We recommend that you reboot the Web server after installation. 

 
Assign Permissions for Web Timekeeper 

\TK Folder 

The \TK folder below the main Web Timekeeper folder must be made available via IIS. 
Right-click the folder in Explorer and assign Web Sharing, using any alias you want. 
Normal web sharing is all that is required. (That is, on the Security tab, the Internet 
Guest Account should have Read & Execute, List Folder Contents, and Read 
permissions). A “DeltekSema4” user account has been created with Password1 as the 
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password. You should change this password after the installation is complete. 

THE IIS User IUSR_MACHNINENAME 

 Should automatically be assigned Full Permissions to the Web Timekeeper folder 
and all files in the folder. (Please make sure that this has occurred.) 

 Must be assigned Full Permissions to the Time Table folder(s). 
 Must be assigned Full Permissions to the \Data folder below the main Sema4 

program folder. 
 

 
Tell Users How to Connect to Web Timekeeper 

To run Web Timekeeper, users need to open Internet Explorer and enter the URL or IP 
address of the Web server. The following are examples of what to enter. 

 HTTP://INTRANET/TK 
 HTTP://TIMESHEETS 
 HTTP://X.X.X.X/TK 

The easiest way to give users access to Web Timekeeper is to create a logon shortcut 
and email it to all users. 
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Chapter 9: Upgrade from Sema4 9.1 — Novell Network 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Anti-virus 
software 

 

 

Multiple sets of 
data 

This section guides you through upgrading from a Sema4 9.1 version (9.1, 9.1 (SP1), or 
9.1 SP2 YE) to Sema4 9.1 (SP3) if you use a Novell network to run Sema4 and your 
copy of the Sema4 9.1 version was installed using the /netware switch. 

For this installation you must upgrade using the machine that was originally used to 
installed Sema4 9.1 with the /netware switch. The reason for this is that on this 
machine, the Sema4 installation program creates Windows registry entries that identify 
where the Sema4 program files are located. For the installation utility to find the Sema4 
9.1 program files and work properly, you must be sure that the Netware drive to the 
Sema4 program files is still mapped the same way on the machine from which you ran 
the Sema4 installation program for Sema4 9.1, 9.1 (SP1), or 9.1 SP2 YE. 

If the machine that was originally used to install the Sema4 9.1 version on Novell is no 
longer available or if your Sema4 9.1 version was installed on a Windows machine and 
the files were manually copied to Novell, please follow the instructions in Chapter 10: 
Upgrade from Sema4 9.0 — Novell Network.“ 

The Sema4 Check for Sema4 Updates utility works only on the machine from which 
you installed Sema4 (on your Sema4 server). Sema4 installation program creates 
Windows registry entries that identify where the Sema4 program files are located. For 
the Check for Sema4 Updates utility to find the Sema4 program files and work 
properly, you must be sure that the Netware drive to the Sema4 program files is always 
mapped on the machine that ran the Sema4 installation program. 

 

The installation process consists of the following steps: 

STEP 1 — Prepare your Sema4 9.1 database for upgrading 

STEP 2 — Back up your Sema4 9.1 folder (program, report, and data files) 

STEP 3 — Download the Sema4 9.1 (SP3) installation files 

STEP 4 — Install Sema4 9.1 (SP3) to your Novell server 

STEP 5 — Upgrade Web Timekeeper, if you have it installed 

STEP 6 — Install Sema4 9.1 (SP3) on your client workstations 

 
Please review all of the instructions before you begin your software installation. 

If you moved Sema4 program and data folders (including the Sema4 Data, Rpt, and 
Keydata folders) to locations other than where they were originally installed, you must 
return them to the original default location (for example to Program Files\Deltek\S490) 
before you begin the installation. After you install Sema4 9.1 (SP3), you can move the 
folders back to their previous locations. 

If you are using anti-virus software, review the documentation from your anti-virus 
program on what to do when installing new applications, and take any necessary steps. 
If you are at all unsure of what to do, please disable the software until you have 
completed the installation. 

Close all other programs before you run the Sema4 Setup routine. 

If you need to install a multiple license data setup for Sema4 9.1 (SP3) , please contact 
a Deltek Sema4 support analyst for additional instructions and documentation. 
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Prepare your Sema4 9.1 Database for Upgrading 

Before you upgrade to Sema4 9.1 (SP3) on your network server, you must follow the 
steps in Appendix B: Prepare Your Current Sema4 Data for Upgrading. 

 

Backup your Sema4 9.1 Directory 

Be sure to make a full backup of your Sema4 directory with all contents intact. For 
further information on backing up, see Appendix A: Sema4 Backup Procedures. 

 

Download the Sema4 9.1 (SP3) Installation File 

To download the Sema4 9.1 (SP3) installation file from the Deltek e-Support site if 
you currently have a Sema4 9.1 version installed: 

 
1. Go to http://support.deltek.com/distribution/DeltekSema4.aspx. 

2. Log on with your e-Support/RNT username and password. 

3. In the Deltek Sema4 Downloads dialog where Sema4 9.1 (SP3) is listed: 

• Click the Deltek Sema4 9.1 (SP3) Release Notes button to download a 
copy of the release notes. 

• Click the Deltek Sema4 9.1 (SP3) button to download the 
DeltekSema491SP3Patch.exe installation file. 

 

Install Sema4 9.1 (SP3) to Your Novell Server 

Warning: 

The Sema4 9.1 (SP3) installation overwrites and upgrades your Sema4 9.1 
software. Because it does not install Sema4 9.1 (SP3) separately from your 
previous Sema4 9.1 version, it is important that you make a full backup of your 
Sema4 9.1 folder (data, report, and program files) before you install Sema4 9.1 
(SP3). 

The person installing Sema4 must have full administrative rights to the server as well as 
full rights to the folder where Sema4 will be installed. 

Neither Sema4 nor RTE are designed to run directly over a wide area network. If you 
use a WAN, such as Citrix Metaframe or Terminal Services, attempting to do so can 
result in data and index corruption. If you have any further questions please contact 
Deltek Sema4 Support. 
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To install Deltek Sema4 9.1 (SP3) on your Novell server if you currently have a 
Sema4 9.1 version installed: 

1. From a Windows machine, select Windows Start » Run. 

2. In the Open field on the Run dialog, type the path to and the name of the 
DeltekSema491SP3Patch.exe file along with the /netware switch and click OK. 

<drive>:\DeltekSema491SP3Patch.exe /netware 

 

3. The installation program will recognize where Sema4 9.1 was installed. If you do 
not get the following message, please follow the instructions in Chapter 10: 
Upgrade from Sema4 9.0 — Novell Network.“ 

 

4. On the Welcome dialog, click Next. 
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5. On the Ready to Install the Program screen, click Install. 

 

The Setup Status dialog opens, and you see the status of the installation progress 
as the software is installed. 

 

 

 

 

Release Notes   55 



Release Notes 

In the Sema4 Cleanup Procedure Status dialog you see a check mark in each 
check box as the cleanup item is completed. 

NOTE: If the Cleanup Procedures do not run automatically, please call Sema4 
Support. 

 

6. On the S4cleanup dialog where you see the successful cleanup results, click the X 
button in the upper right to close the dialog. 

 

7. On the Update Complete dialog, click Finish. 

 

8. Reboot your server. 

You have completed the installation of Sema4 9.1 (SP3) on your Novell network server. 
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Upgrade Web Timekeeper 

Sema4 9.1 (SP3) Web Timekeeper cannot be installed on a Novell server. 
 
If you have a Sema4 9.1 version of Web Timekeeper installed on another Windows 
server machine, you can upgrade it to Sema4 9.1 (SP3) by doing the following: 
 
1. Complete the steps in the “Install Sema4 9.1 (SP3) on Your Network Server” 

section on page 23. This upgrades your 9.1 Web Timekeeper to 9.1 (SP3). 

2. Follow the instructions in the “Install the Sema4 9.1 (SP3) Web Timekeeper 
Reports” section on page 28. This adds the new WEBTK.FRX report file to the Time 
Table directories and finishes the Web Timekeeper upgrade. 

 

 

 

Because Help 
and 
documentation 
formats have 
been updated in 
the software, 
you MUST run 
the workstation 
setup for all 
users. 

 

Install Sema4 9.1 (SP3) on Your Client Workstations 

Skip this step for the machines that had the client workstation installed in 9.1. 

After you install Sema4 9.1 (SP3) on your Novell network server, you must install the 
application (or selected components) on any new client workstation that will run Sema4 
(or selected components). 

If you need to install a multiple license data setup for Sema4 9.1 (SP3), please contact 
Deltek Sema4 Support for additional instructions and documentation. 

 

To install Deltek Sema4 9.1 (SP3) on a client workstation: 

1. From the client workstation, use Windows Explorer to navigate to the network share 
created during the server installation (that is, <Your Server>\S490). 

2. Double-click DeltekSema491Client.exe to start the installation. 
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3. On the Welcome dialog, click Next. 

 

 

4. On the License Agreement dialog, read the license agreement, select the I accept 
the terms of the license agreement option, and click Next. 
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5. On the Start Copying Files dialog, review the information in the Current Settings 
box, and click Next. 

 

 

The Setup Status dialog displays the installation progress. 
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6. On the Deltek Sema4 Installation Wizard Complete dialog, click Finish. 

 

You have completed the installation of Sema4 9.1 (SP3) on this workstation. 

Please reboot the workstation before you begin using Sema4 9.1 (SP3) on this 
workstation. 

Repeat these steps to install Sema4 9.1 (SP3) on other workstations. 
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Chapter 10: Upgrade from Sema4 9.0 — Novell Network 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This section guides you through upgrading to Sema4 9.1 (SP3) for either of the 
following scenarios: 

• You have Sema4 9.0 currently installed and you use a Novell network to run 
Sema4. 

• You have a Sema4 9.1 version installed; it was installed on a Windows 
machine; and the files were manually copied to Novell. 

If you are upgrading from a Sema4 9.1 version as described, when you follow 
the instructions in this chapter to upgrade, reference to Sema4 9.0 also applies 
to Sema4 9.1. 

The main difference when installing Sema4 9.1 (SP3) on a Novell network is that you 
must run the installation program (DeltekSema491SP3.exe) with the /NetWare switch. 
This enables you to install to a Netware share. You run the Sema4 installation program 
from a Windows machine to install Sema4 to your Novell server. 

The Sema4 Check for Sema4 Updates utility works only on the machine from which 
you installed Sema4 (on your Sema4 server). The reason for this is that on this 
machine, the Sema4 installation program creates Windows registry entries that identify 
where the Sema4 program files are located. For the Check for Sema4 Updates utility 
to find the Sema4 program files and work properly, you must be sure that the Netware 
drive to the Sema4 program files is always mapped on the machine that ran the Sema4 
installation program. 

Please read these installation instructions carefully because they are different from 
previous Sema4 installations. 

 
IMPORTANT INSTALLATION CHANGES 

The Sema4 9.1 (SP3) installation overwrites and upgrades your Sema4 9.0 
software. Because it does not install 9.1 (SP3) in addition to your previous 9.0 
software, it is important that you make a full backup of your Sema4 9.0 folder (data, 
report, and program files) before you install Sema4 9.1 (SP3). 

 
The installation process consists of the following steps: 

STEP 1 — Prepare your Sema4 9.0 database for upgrading 

STEP 2 — Back up your Sema4 9.0 folder (program, report, and data files) 

STEP 3 — Download the Sema4 9.1 (SP3) installation files 

STEP 4 — Install Sema4 9.1 (SP3) to your Novell server 

STEP 5 — Upgrade Web Timekeeper, if you have it installed 

STEP 6 — Install Sema4 9.1 (SP3) on your client workstations 

STEP 7 — Update Sema4 Remote Entries 
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Anti-virus 
software 

 

Do you have 
multiple data 
sets? 

  Important Notes 

• Before you install Sema4 9.1 (SP3), make sure all Sema4 directory and file 
attributes are not marked as read-only or hidden. 

• Close all other programs before you run the Sema4 Setup routine. 

• If you are using anti-virus software, review the documentation from your anti-
virus program on what to do when installing new applications, and take any 
necessary steps. If you are at all unsure of what to do, please disable the 
software until you have completed the installation. 

• If you need to install a multiple license data setup for Sema4 9.1 (SP3), please 
contact a Deltek Sema4 support analyst for additional instructions and 
documentation. 

 
 

Prepare your Sema4 9.0 Database for Upgrading 

Before you upgrade to Sema4 9.1 (SP3) on your network server, you must follow the 
steps in Appendix B: Prepare Your Current Sema4 Data for Upgrading. 

 

Backup your Sema4 9.0 Folder 

Be sure to make a full backup of your Sema4 directory with all contents intact. For 
further information on backing up, see Appendix A: Sema4 Backup Procedures. 

 

Download the Sema4 9.1 (SP3) Installation File 

To download the Sema4 9.1 (SP3) installation file from the Deltek e-Support site if 
you currently have a Sema4 9.0 version installed: 

 
1. Go to http://support.deltek.com/distribution/DeltekSema4.aspx. 

2. Log on with your e-Support/RNT username and password. 

3. In the Deltek Sema4 Downloads dialog where Sema4 9.1 (SP3) is listed: 

• Click the Deltek Sema4 9.1 (SP3) Release Notes button to download a 
copy of the release notes. 

• Click the Deltek Sema4 9.1 (SP3) button to download the 
DeltekSema491SP3.exe installation file. 
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Install Sema4 9.1 (SP3) to Your Novell Server 

Warning: 

The Sema4 9.1 (SP3) installation overwrites and upgrades your Sema4 9.0 
software. Because it does not install Sema4 9.1 (SP3) separately from your 
previous Sema4 9.0 version, it is important that you make a full backup of your 
Sema4 9.0 folder (data, report, and program files) before you install Sema4 9.1 
(SP3). For more information on backing up, see Appendix A: Sema4 Backup 
Procedures. 

The person installing Sema4 must have full administrative rights to the server as well as 
full rights to the folder where Sema4 will be installed. 

Neither Sema4 nor RTE are designed to run directly over a wide area network. If you 
use a WAN, such as Citrix Metaframe or Terminal Services, attempting to do so can 
result in data and index corruption. If you have any further questions please contact 
Deltek Sema4 Support. 

 
To install Deltek Sema4 9.1 (SP3) on your Novell server if you currently have a 
Sema4 9.0 version installed: 

1. From a Windows machine, select Windows Start » Run. 

2. In the Open field on the Run dialog, type the path to and the name of the 
DeltekSema491SP3.exe file along with the /netware switch and click OK. 

<drive>:\DeltekSema491SP3.exe /netware 
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3. On the Welcome dialog, click Next. 

 

 

4. On the License Agreement dialog, read the license agreement, select the I accept 
the terms of the license agreement option, and click Next. 
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5. On the Choose Destination Location dialog, do not accept the prefilled default 
location (C:\Program Files\Deltek\S490). Instead, click Change, and enter the 
Novell location where you want Sema4 installed. Then on the Choose Destination 
Location dialog, click Next. 

 

 

6. On the Select Features dialog, be sure the Sema4 check box is selected and click 
Next. 

On this dialog, you see only Sema4 and not Web Timekeeper because Web 
Timekeeper cannot be installed on a Novell server. 
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7. On the Start Copying Files dialog, review the information in the Current Settings 
box, and click Next to start the installation. 

 

 

The Setup Status dialog opens, and you see the status of the installation progress 
as the software is installed. 
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In the Sema4 Cleanup Procedure Status dialog you see a check mark in each 
check box as the cleanup item is completed. 

NOTE: If the Cleanup Procedures do not run automatically, please call Sema4 
Support. 

 

8. On the S4cleanup dialog where you see the successful cleanup results, click the X 
button in the upper right to close the dialog. 

 

9. On the Update Complete dialog, click Finish. 

 

10. Reboot your server. 

You have completed the installation of Sema4 9.1 (SP3) on your Novell network server. 
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Upgrade Web Timekeeper 

Sema4 9.1 (SP3) Web Timekeeper cannot be installed on a Novell server. 
 
If you have a Sema4 9.0 version of Web Timekeeper installed on another Windows 
server machine, you can upgrade it to Sema4 9.1 (SP3) by doing the following: 
 
1. Complete the steps in the “Install Sema4 9.1 (SP3) on Your Network Server" on 

page 23. This upgrades your 9.0 Web Timekeeper to 9.1 (SP3). 

2. Follow the instructions in the “Install New Web TimeKeeper Reports” section on 
page 28. This adds the new WEBTK.FRX report file to the Time Table directories 
and finishes the Web Timekeeper upgrade. 

 

 

 

Because Help 
and 
documentation 
formats have 
been updated in 
the software, 
you MUST run 
the workstation 
setup for all 
users. 

 

Install Sema4 9.1 (SP3) on Your Client Workstations 

After you install Sema4 9.1 (SP3) on your Novell network server, you must install the 
application (or selected components) on each client workstation that will run Sema4 (or 
selected components). 

If you are using anti-virus software, review the documentation from your anti-virus 
program on what to do when installing new applications, and take any necessary steps. 
If you are at all unsure of what to do, please disable the software until you have 
completed the installation. 

If you need to install a multiple license data setup for Sema4 9.1 (SP3), please contact 
Deltek Sema4 Support for additional instructions and documentation. 
 

To install Deltek Sema4 9.1 (SP3) on a client workstation: 

1. From the client workstation, use Windows Explorer to navigate to the network share 
created during the server installation (that is, <Your Server>\S490). 

2. Double-click DeltekSema491Client.exe to start the installation. 
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3. On the Welcome dialog, click Next. 

 

4. On the License Agreement dialog, read the license agreement, select the I accept 
the terms of the license agreement option, and click Next. 
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5. On the Start Copying Files dialog, review the information in the Current Settings 
box, and click Next. 

 

 

The Setup Status dialog displays the installation progress. 

 

 

 

 

70   



 Chapter 10: Upgrade from Sema4 9.0 — Novell Network 

6. On the Deltek Sema4 Installation Wizard Complete dialog, click Finish. 

 

You have completed the installation of Sema4 9.1 (SP3) on this workstation. 

Please reboot the workstation before you begin using Sema4 9.1 (SP3) on this 
workstation. 

Repeat these steps to install Sema4 9.1 (SP3) on other workstations. 

 
Update Sema4 Remote Entries 

To update remote entries from Sema4 9.0 to 9.1 (SP3), see Appendix C: Update to 
Remote Entries in Sema4 9.1. 
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Anti-virus 
software 

 

Do you have 
a  sets of 
data? 

This section guides you through upgrading from a Sema4 8.x version to Sema4 9.1 
(SP3) if you use a Novell network. 

The main difference when installing Sema4 9.1 (SP3) on a Novell network is that you 
must run the installation program (DeltekSema491SP3.exe) with the /NetWare 
switch. This enables you to install to a Netware share. You run the Sema4 
installation program from a Windows machine to install Sema4 to your Novell server. 

The Sema4 Check for Sema4 Updates utility works only on the machine from which 
you installed Sema4 (on your Sema4 server). The reason for this is that on this 
machine, the Sema4 installation program creates Windows registry entries that 
identify where the Sema4 program files are located. For the Check for Sema4 
Updates utility to find the Sema4 program files and work properly, you must be sure 
that the Netware drive to the Sema4 program files is always mapped on the machine 
that ran the Sema4 installation program. 

The installation process consists of the following steps: 

STEP 1 — Prepare your 8.x database for upgrading 

STEP 2 — Back up your Sema4 8.4 folder (program, report, and data files) 

STEP 3 — Download the 9.1 (SP3) installation files 

STEP 4 — Install Sema4 9.1 (SP3) to your Novell server 

STEP 5 — Assign file rights and permissions 

STEP 6 — Initialize your Sema4 9.1 license if necessary 

STEP 7 — Upgrade your Sema4 data 

STEP 8 — Install Sema4 9.1 (SP3) on your client workstations 

STEP 9 — Update Sema4 remote entries 

STEP 10 — Upgrade Web Timekeeper 

Please review all of the instructions before you begin your software installation. 

 Important Notes 

• Before you install Sema4 9.1 (SP3), make sure all Sema4 directory and file 
attributes are not marked as read-only or hidden. 

• Close all other programs before you run the Sema4 Setup routine. 

• If you are using anti-virus software, review the documentation from your anti-
virus program on what to do when installing new applications, and take any 
necessary steps. If you are at all unsure of what to do, please disable the 
software until you have completed the installation. 

• If you need to install a multiple license data setup for Sema4 9.1 (SP3), 
contact Deltek Sema4 Support for instructions and documentation. 
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Prepare your Sema4 8.x Database for Upgrading 

Before you upgrade to Sema4 9.1 (SP3) on your network server, you must follow the 
steps in Appendix B: Prepare Your Current Sema4 Data for Upgrading. 

 

Backup your Sema4 8.x Directory 

Be sure to make a full backup of your Sema4 directory with all contents intact. For 
further information on backing up, see Appendix A: Sema4 Backup Procedures. 

 

Download the Sema4 9.1 (SP3) Installation File 

To download the Sema4 9.1 (SP3) installation file from the Deltek e-Support 
site if you currently have a Sema4 8.x version installed: 

1. Go to http://support.deltek.com/distribution/DeltekSema4.aspx. 

2. Log on with your e-Support/RNT username and password. 

3. In the Deltek Sema4 Downloads dialog where Sema4 9.1 (SP3) is listed: 

• Click the Deltek Sema4 9.1 (SP3) Release Notes button to download a 
copy of the release notes. 

• Click the Deltek Sema4 9.1 (SP3) button to download the 
DeltekSema491SP3.exe installation file. 

 

Install Sema4 9.1 (SP3) to Your Novell Server 

To begin the installation process, you must first install Sema4 9.1 (SP3) on your 
network server. The person installing Sema4 must have full administrative rights to 
the server as well as full rights to the folder where Sema4 will be installed. 

Neither Sema4 nor RTE are designed to run directly over a wide area network. If you 
use a WAN, such as Citrix Metaframe or Terminal Services, attempting to do so can 
result in data and index corruption. If you have any further questions please contact 
Deltek Sema4 Support. 

To install Deltek Sema4 9.1 (SP3) on your Novell server: 

1. From a Windows machine, select Windows Start » Run. 

2. In the Open field on the Run dialog, type the path to and the name of the 
DeltekSema491SP3.exe file with the /netware switch and click OK. 

<drive>:\DeltekSema491SP3.exe /netware 
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3. On the Welcome dialog, click Next. 

 

4. Read the agreement on the License Agreement dialog, select the I accept the 
terms of the license agreement option, and click Next. 
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5. On the Choose Destination Location dialog, do not accept the prefilled default 
location (C:\Program Files\Deltek\S490). Instead, click Change, and enter the 
Novell location where you want Sema4 installed. Then on the Choose 
Destination Location dialog, click Next. 

 

6. On the Select Features dialog, be sure the Sema4 check box is selected and 
click Next. 

On this dialog, you see only Sema4 and not Web Timekeeper because Web 
Timekeeper cannot be installed on a Novell server. 
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7. In the Start Copying Files dialog review the information in the Current Settings 

box, click Next to start the installation. 

 

The Setup Status dialog opens, and you see the installation progress as the 
software is installed. 
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In the Sema4 Cleanup Procedure Status dialog you see a check mark in each 
check box as the cleanup item is completed. 

NOTE: If the Cleanup Procedures do not run automatically, please call Sema4 
Support. 

 

8. On the S4cleanup dialog where you see the successful cleanup results, click the 
X button in the upper right to close the dialog. 

 

9. On the Deltek Sema4 Installation Wizard Complete dialog, click Finish. 

 

10. Reboot your server. You have completed the installation on your server. 
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The Update 
utility first 
imports your 
data, including 
your Sema4 
license, invoice 
designs, and 
report designs. 

Then, based on 
the selections in 
this dialog, it 
offers to replace 
the pre-
designed 
invoice and 
report designs 
with the newest 
versions. 

Run the Update Data Program 

To run the Update Data Program: 

1. Select Windows Start » Run. 

2. Browse to the Sema4 Version 9.1 folder, and select UPDATE.EXE to start the 
update program. 

3. On the Update Sema4 for Windows dialog, complete the following, and then click 
OK. 

 

 Select the options for the 8.x old version of Sema4 you are using. 

 The Data directory for Version 9.1 field prefills. 

 Use the  button to find and make a selection in the Data directory for old 
version field. 

 Append 9.1 sample designs for — Select the check boxes for the standard 
designs you want to update. 

We recommend that you select all of them to ensure that your upgrade 
includes all of the new features. If you are concerned that you might 
overwrite customized designs during the upgrade, contact Technical Support 
for assistance. 

A series of messages appears that reads, “Checking Data File..., Recovering 
Data File..., Updating Data File...,” and so on. 

 

 

 

 

 

78   



 Chapter 11: Upgrade from Sema4 8.x — Novell Network 

4. When an ID is found in one of your design files that matches one of the sample 
IDs, a dialog box similar to the following opens. 

 

The utility offers to place the newest version of the sample design specified in 
your files. In general, you should select Overwrite All in every case. If you have 
changed a standard design without assigning it a new ID, you must select either 
Change ID or Ignore Sample to retain your changes. 

 Ignore Sample — Leaves the existing (old) design in your file, and moves 
on to checking the next ID. 

 Ignore All — Cancels the attempt to add or replace the remaining designs in 
the current file, leaving all of the old designs in place. 

 Overwrite — Replaces the existing (old) design in your file with the new 
sample design. 

 Overwrite All — Replaces all remaining designs in the current file with the 
new sample designs. 

 Change ID — Opens the following dialog, which allows you to copy the 
sample design into your file, assigning it a different ID. 

 
 

 
Assign File Rights and Permission 

See Appendix E: Assign File Rights and Permissions When Using a Novell Network. 

 
 

If You Need To Initialize Your Sema4 License 

You need to initialize your Sema4 license only if you are installing Sema4 for the first 
time or you have just upgraded your license. For initializing instructions, see Appendix 
F: Initializing your Sema4 License. 
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Because Help 
and 
documentation 
have been 
updated in the 
software, you 
MUST run the 
workstation 
setup for all 
users. 

 

Install Sema4 9.1 on Your Client Workstations 

After you install Sema4 9.1 (SP3) on your Novell server, assign file rights and 
permissions, initialize your license, and update your data, you must install the 
application (or selected components) on each client workstation that will run Sema4 (or 
selected components). 

If you are using anti-virus software, review the documentation from your anti-virus 
program on what to do when installing new applications, and take any necessary steps. 
If you are at all unsure of what to do, please disable the software until you have 
completed the installation. 

If you need to install a multiple license data setup for Sema4 9.1 (SP3), please contact 
Deltek Sema4 Support for additional instructions and documentation. 

To install Deltek Sema4 9.1 (SP3) on a client workstation: 

1. From the client workstation, use Windows Explorer to navigate to the network share 
created during the server installation (<Server>\S490). 

2. Double-click DeltekSema491Client.exe to start the installation. 

3. In the Welcome dialog, click Next. 
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4. On the License Agreement dialog, read the license agreement, select the I accept 
the terms of the license agreement option, and click Next. 

 

 

5. On the Start Copying Files dialog, review the information in the Current Settings 
box, and click Next. 
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The Setup Status dialog displays the installation progress. 

 

 
6. On the Deltek Sema4 Installation Wizard Complete dialog, click Finish. 

 

You have completed the installation of Sema4 9.1 (SP3) on this workstation. 

Please reboot the computer before you begin using Sema4 9.1 (SP3) on this 
workstation. 

Repeat these instructions to install Sema4 9.1 (SP3) on other workstations. 
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Update to Remote Entries in Sema4 9.1 (SP3) 

For instructions on how to update remote entries from Sema4 8.x to Deltek Sema4 9.1 
(SP3), see Appendix C: Update to Remote Entries in Sema4 9.1 

 
 

Upgrade Web Timekeeper 

Sema4 9.1 (SP3) Web Timekeeper cannot be installed on a Novell server. 
 
If you have a Sema4 8.x version of Web Timekeeper installed on another Windows 
server machine, you can upgrade it to Sema4 9.1 (SP3) by completing the instructions 
in Chapter 7: Upgrade from Sema4 8.x — Installation. 
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Appendix A: Sema4 Backup Procedures 

  

Backups are crucial to the integrity of your data. On the rare occasion that you receive 
an error in Sema4 that our technicians cannot resolve or if your data becomes corrupted 
due to a power outage or other problem, you can restore the backup. If backups are 
done daily, any data lost can be reentered relatively quickly. In addition to backing up 
your data, you should also occasionally test your backups. 

 

Daily and Period Backup Required 

\S490\Data 

A complete back up of \S490\Data files should be made daily, with period-end backups 
being retained until each fiscal year is closed. Incremental backups are not 
recommended and are ineffective in protecting your valuable financial data. 

 

Periodic Backup Needed 

Main Program Folder (\S490) 

The program executable files and help files are stored here. 

 

\S490\Rpt 

Report design files (*.FRX and *.FRT) are stored here. Back up all files periodically to 
preserve any changes you have made to the pre-designed reports, as well as any files 
created by the Single File Report Design module. 

 

Web Timekeeper installed on a separate server 
 
If you have Web Timekeeper installed on a separate server, be sure to periodically back 
up the Web Timekeeper time table folder (usually named Site). WebTimeKeeper 
information is imported into Sema4, and you should be backing up Sema4 data daily, so 
it is not as critical to back up the Web Timekeeper time table folder on a daily basis. 
However, backing it up regularly may prevent users from having to reenter a portion of 
their timesheets if the information has not yet been imported and you happen to lose the 
time table folder. 
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Appendix B: Prepare Your Current Sema4 Data for Upgrading 

 

 

If you are using a 
customized version 
of Sema4, do not 
install this upgrade 
unless you have 
checked with 
application support. 

 

 

 

For more 
information about 
Clean up 
procedures, see 
Chapter 3-8 of the 
User’s Guide or the 
Year End 
Procedure Manual 
—Appendix A. 

 

 

 

 

 

 

 

Follow these instructions to prepare your current Sema4 data before you perform 
the upgrade instructions in the Upgrade Installation chapters. 

For any Sema4 version (8.x, 9.0, or 9.1) that you currently have installed, you must 
prepare your current data before you install the Sema4 9.1 (SP3) upgrade. 

To prepare your current Sema4 data for upgrading: 

Make sure that no one else is using Sema4 or will try to do so before you have 
finished the upgrade. 

1. Open your existing Sema4 software. 

2. From the Utilities menu, select Clean Up Data Files » Rebuild Sema4 
Database Container, and run the utility. (Version 8.0 does not have this feature 
so you can skip this step for version 8.0.) 

3. For all versions, from the Utilities menu, select Clean Up Data Files » 
Compare File Structure. 

4. On the Compare File Structure dialog, select the Check All Sema4 Databases 
option and click OK. 

5. From the Utilities menu, select Clean Up Data Files » Reindex All Data Files 
and run the utility. 

6. From the Utilities menu, select Clean Up Data Files » Delete Sema4 
Temporary Files to delete temporary files. 

7. Close Sema4. 

8. Using Windows Explorer, navigate to your Sema4 directory and open the Data 
folder. 

9. Delete all the files that are "user.#" files, such as user.1, user.2, and so on. 

10. Make a complete backup of your Sema4 system. See Appendix A: Sema4 
Backup Procedures for more information on backing up. 
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Appendix C: Update to Remote Entries in Sema4 9.1 (SP3) 

 
 These instructions apply if you are upgrading from Sema4 8.x or 9.0 to Sema4 9.1 

(SP3). 

To update remote entries from Sema4 8.x or 9.0 to Deltek Sema4 9.1: 
 
1. Create a new folder called S491 RTE for your Sema4 9.1 Remote Entries. 

2. To perform a Remote Entry Download from Sema4 to the newly created folder: 

a. From the Sema4 main menu, select Time/Expense » Remote Entries » 
Download. 

b. On the Download Remote Entries Utility dialog, select the RTE - Remote 
Timesheet Entries and/or REE – Remote Expense Entries check boxes, 
and select your design in the Screen ID and Description field. 

 

 
c. On the Download Remote Entries Utility dialog, select all options below the 

To Drive:Directory\ section. 

  Note 

This is the only instance in which the Empty RTE DBF or Empty REE DBF 
options should be selected. Never select these options during normal use. 
Selecting these options downloads new, empty data files for timesheets 
and expense reports, overwriting any existing data in RTE. You cannot 
recover the overwritten data. 
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3. To update data from your 8.4/9.0 RTE folder, open Sema4 9.1 (the Financial 
Management software) and select Utilities » Database Tools » Update a Data 
File from the Sema4 main menu. 

 
4. On the Update a Data File dialog: 

(what follows is an example) 

a. For the Target File, browse to the DBF file of the 9.1 RTE folder (that is, 
TM.DBF). 

 
b. For the Source File, browse to the DBF file of the 8.4/9.0 RTE folder (that 

is, TM.DBF). 

Both the Target and Source DBF files should have the same name, but 
different paths. 

c. Repeat the process for all Timesheet and Remote expense designs. 

 
5. Using Windows Explorer, go to the S490 root folder, copy the 

DeltekSema491Client.exe file, and then paste it into the new S491 RTE folder. 

6. Set up each workstation that will access the S491 RTE program by logging in 
with local administrator privileges and navigating to the RTE folder in the file 
manager. 

• In the S491 RTE folder, locate and run the DeltekSema491Client.exe file 
(see “Install Deltek Sema4 9.1 on Your Client Workstations” on page 43 of 
these Release Notes). 

This installation module registers S491 RTE on the workstation and installs a 
Remote Entry shortcut within the Deltek Sema491 program group. 
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Appendix D: Assign File Rights and Permissions 

 You must assign file rights and permissions after you upgrade your server to 
Sema4 9.1 (SP3) from Sema4 9.1, 9.0, or 8.x versions. 

If you use Sema4 with a Novell network, see Appendix E: Assign File Rights and 
Permissions When Using a Novell Network. 

Assign File Rights and Permissions for Windows 

After you install Sema4 9.1 (SP3) on your network server, you need to assign file 
rights and permissions to control access to the application files and directories. 

It is best if all installations and upgrades are done by someone logged in as an 
administrator with full rights to all Sema4 files and directories. However, no one 
should ever use the program while logged on as an administrator. In this way, all 
file permissions can be left with the defaults explained over the next several 
pages. 

We recommend that you set up two groups — S4Users and S4Super. All Sema4 
users will belong to the S4Users group. Certain other users will also belong to the 
S4Super group. 

Users who belong to both groups are those persons in your firm who perform any 
of the following tasks. 

 Act as a manager or accounting supervisor for Sema4 users 
 Run the Archive Accounting Information utility (monthly close) 
 Run the Reindex All Data Files utility 
 Work with the Remote Entry or SITE modules to design screens, download 

setup files, or upload entries 
 Work with the Purchase Order module to download setup files or upload 

entries 
 

Folder access rights are listed by user group in the following table. Descriptions of 
the folders and their contents follow. 

S4 Folder Name S4Super Rights S4Users Rights 

\S490 Modify Modify 

\Data Modify Modify 

\Help Modify Read Only 

\Keydata Modify Read Only if the user 
needs to copy from 
Keydata to Data; otherwise, 
no permissions needed. 

\Rpt Modify Modify if the user runs, 
edits, or creates reports; 
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otherwise, no permissions 
needed. 

\Sample Modify Modify if the user reindexes 
files; Read Only if the user 
needs to run 
NEWVER.EXE to restore 
standard designs; 
otherwise, no permissions 
needed. 

Any other folder 
where saved .frx 
files, batch reports, 
or PM report 
designs are stored 

Modify Modify if the user runs 
reports; otherwise, no 
permissions needed. 

 
  

\S490  Main Program Folder 

The program folder (\S490 by default) contains executable files that store the 
program code. Temporary (temp) files are also created here when users are 
working. Temporary files are created in the program folder every time a user runs 
Sema4, so all users must have modify permissions to create and delete files. 

\Data 

This folder stores all transaction and setup data in files with a .dbf extension. 
Indexes used by the program to speed data retrieval are stored in files with a .cdx 
extension, and all text entered into note fields is stored in files with an .fpt 
extension. Since the files used to track licensing information (User.1, User.2, and 
so on) are also created and stored in the data folder, users must have permission 
to create and modify files here to start Sema4. Once in the program, users need 
to be able to make changes to the data files in order to add, delete, or modify 
existing data. 

\Help 

Online documentation files are stored here. In addition, it has a \PDFS folder 
containing Adobe Acrobat files that are linked to in the User’s Guide. Should any 
of these files become damaged or corrupt, you can restore \Help from a backup or 
contact Deltek Sema4 Support if you need further assistance. 

\Keydata 

This folder contains a copy of a select number of files found in the data folder. 
These files, known as the data dictionary files, describe the structure of the 
Sema4 database and are used for various functions, such as running reports and 
cleanup procedures. The program never actively uses the copies of the files in the 
Keydata folder. If one of the data dictionary files in the data folder becomes 
corrupt, you can use Windows Explorer to manually copy the backup files from 
the Keydata folder into the Data folder to fix the problem. 

\Rpt 

This stores files used to generate reports in Sema4. Anyone who prints a report in 
Sema4 must have modify permissions to the RPT folder, even if they are not 
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going to edit any report designs in Sema4. 

\Sample 

This folder contains files that store a copy of all standard invoices, billing formats, 
financial statement designs, SQL commands, and remote timesheet designs. In 
the event that you need to restore standard designs, the NEWVER.EXE file can 
be used to copy the original designs from the sample folder into the data folder. 
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Appendix E: Assign File Rights and Permissions When Using 
a Novell Network 

 
Assign File Rights and Permissions 

After you install Sema4 9.1 (SP3) on your Novell server, you need to assign file 
rights and permissions to control access to the application files and directories. 

It is best if all installations and upgrades are done by someone logged in as an 
administrator with full rights to all Sema4 files and directories. However, no one 
should ever use the program while logged on as an administrator. In this way, all 
file permissions can be left with the defaults explained over the next several 
pages. 

File Rights on a Novell NetWare Network Drive 
We recommend that you set file rights as follows: 

For Novell NetWare Version 3.x 

1. Flag all files in the main Sema4 program directory and below as Shared 
Read Write: 

2. FLAG *.* SRW SUB /C 

3. Flag program files in the main Sema4 program directory as Shared Read 
Only: 

4. FLAG *.EXE SRO /C 

5. Flag all files in the \Help directory as Shared Read Only:  

CD HELP 

FLAG *.* SRO 

For Novell NetWare Version 4.x, Version 5, or Version 6 

1. Flag all files in the main Sema4 program directory and below as Shared 
Read Write: 

2. FLAG *.* SH RW /S /C 

3. Flag program files in the main Sema4 program directory as Shared Read 
Only: 

4. FLAG *.EXE SH RO /C 

5. Flag all files in the \Help directory as Shared Read Only: 

CD HELP 

FLAG *.* SH RO 
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File Rights For Novell NetWare 
Although the main program directory (by default \S490) can be renamed during 
installation or afterward, the names assigned to its subdirectories must not be 
changed, even if they are relocated. 

In the main program directory (\S490) 

All files should be flagged Shared Read Write, except for program files (*.exe) 
which should be Shared Read Only. 

In \DATA 

All files should be flagged Shared Read Write. When Sema4 runs, it creates 
additional files in this directory named User.1, User.2, User.3, etc., one for each 
active user. These files are created as Non-Shareable and Read-Only. Normally 
they are automatically deleted by Sema4 when not needed. If no one is using 
Sema4 you can safely delete any such files, and it is important that you do not 
accidentally flag them as sharable or delete-inhibit. 

In \Help 

All files should be flagged Shared Read Only. No user should have the rights to 
create files in this directory. 

In \RPT 

All files should be flagged Shared Read Write, although most users have only 
Read access. 

In \SAMPLE 

All files should be flagged Shared Read Write, although most users have only 
Read access. 

In \KEYDATA 

All files should be flagged Shared Read Write, although most users have only 
Read access. 

User Groups for Novell NetWare 
We recommend that you set up two groups, S4USERS and S4SUPER. All 
Sema4 users belong to S4USERS, with certain users also belonging to 
S4SUPER. Those who belong to both groups are users who will do any of the 
following tasks: 

• Act as a manager or accounting supervisor for Sema4 users. 

• Run the Archive Accounting Information utility (monthly close) 

• Run the Reindex All Data File utility. 

• Work with the Remote Entry or SITE modules to design screens, 
download setup files, or upload entries. 

• Work with the Purchase Order module to download setup files or upload 
entries. 

• Alter or create report designs (via Modify FRX, SF Custom Report 
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Generator, or SQL Command). 

 

S4USERS Group Rights 
 NetWare 3.x, 4.x, 5.x, or 6 

Program directory (\S490) Read, Write, Create, Erase, Modify, Filescan 

\Data Read, Write, Modify, Filescan 

\Help Read, Filescan 

\Rpt Read, Filescan 

\Sample Read, Filescan 

\Keydata Read, Filescan 

 

Additional Rights for S4SUPER Group 
 NetWare 3.x, 4.x, 5.x, or 6 

\Data READ, WRITE, CREATE, ERASE, MODIFY, FILESCAN

\Rpt READ, WRITE, CREATE, ERASE, MODIFY, FILESCAN

\Sample READ, WRITE, CREATE, ERASE, MODIFY, FILESCAN

\Keydata READ, WRITE, CREATE, ERASE, MODIFY, FILESCAN
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Appendix F: Initializing your Sema4 License 

 
If You Need To Initialize Your Sema4 License 

If you are upgrading from a previous version of Sema4, you can skip this step. 
Your license information is automatically updated during the system upgrade.  

You need to initialize your Sema4 license only if you are installing Sema4 for 
the first time or you have just upgraded your license. 

 

1. To open Sema4, select Programs » Deltek Sema4 9.1 » Sema4 from the 
Windows Start menu. When you start Sema4 for the first time, the following 
dialog box opens. 

 

 

2. Insert the license disk in your computer drive. If the drive letter is not A:, press 
the  button and select the correct drive. 

3. Click OK. This initializes the license. The following dialog box opens. 

 

 

4. You need to restart Sema4 before the license takes effect. Click the OK 
button again to close Sema4. 

Sema4 is installed and initialized on your network. 
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Appendix G: Web Timekeeper — "Error: Access is Denied" 
 
 

 

If you use Web Timekeeper, after you upgrade to Sema4 9.1 (SP3) you will receive an 
"Error: Access is Denied." message when you try to open Web Timekeeper. 
 

 
 
This happens because the IUSR account is overwritten with the Deltek Sema4 Local 
IUSR account during the Sema4 installation. To fix this, you must stop Internet 
Information Services (IIS), reinstate the correct IUSR account if S490 and Web 
Timekeeper are on different servers or reset the password if both are on the same 
server, and then restart IIS. 
 
To do this, complete the following steps: 

1. From your Desktop, click Windows Start » Control Panel. 

2. From the Control Panel window, double-click Administrative Tools, and in the 
Administrative Tools window, double-click Internet Information Services. 

3. Expand the IIS tree in the left pane by clicking the plus signs until you can see 
Default Web Site within the Web Sites folder in the left pane. 
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4. Right-click Default Web Site, and from the shortcut menu, click Stop. 

 
 

5. In the left pane of the Internet Information Services window, click the plus sign to 
the left of Default Web Site to expand it so you can see TK. 
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6. Right-click TK, and from the shortcut menu, click Properties. 

 
 

7. In the TK Properties window, click the Directory Security tab. 
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8. On the Directory Security tab, click the Anonymous access and authentication 
control Edit button. 

9. In the Authentication Methods window, you see the DeltekSema4 user name and 
password. in the Anonymous access section. Replace it with the appropriate user 
name and password (domain IUSR account) only if Web Timekeeper and S490 are 
on separate servers, and click OK. 

 
 

10. In the TK Properties window, click Apply, then click OK, and close the Internet 
Information Services window. 

11. If Web Timekeeper is on the same server as S490, from your Desktop, click 
Windows Start » Control Panel. 
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12. From the Control Panel window, double-click Administrative Tools, and in the 
Administrative Tools window, double-click Computer Management. 

 
 

13. In the left pane of the Computer Management window, click the plus sign to the left 
of Local Users and Groups to expand and display Users within Local Users and 
Groups. 
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14. In the right pane of the Computer Management window, right-click DeltekSema4, 
and from the shortcut menu, select Set Password. 

 
 

15. In the Set Password for DeltekSema4 window, click Proceed. 

 
 

16. In the Set Password for DeltekSema4 window, enter an appropriate password, and 
click OK. 
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17. Close the Computer Management window. 

18. From your Desktop, click Windows Start » Control Panel. 

19. From the Control Panel window, double-click Administrative Tools, and in the 
Administrative Tools window, double-click Internet Information Services. 

20. Expand the Internet Information Services tree in the left pane by clicking the plus 
signs until you can see Default Web Site within the Web Sites. 

 
 

21. Right-click Default Web Site, and from the shortcut menu, click Start. 

 

Release Notes   101 



Release Notes 

 
You can now open Web Timekeeper without receiving the access denied error. 
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Appendix H: Sema4 9.1 (SP3) Optional Web Timesheet Grid 
Reports 

 After you upgrade to Sema4 9.1 (SP3), you have the option to replace the existing 
Biweekly, Daily, Semimonthly, and Weekly Web Timesheet reports with a new ones that 
display hours worked and project/phase/task in a grid. 

Because the files for the new reports have the same name as the original report files, 
you need to rename the existing Web Timekeeper report files, and then copy in the new 
report files. 

Complete the following steps to copy the new Web Timekeeper report to your 
Time Table\Site directory: 

1. Use Microsoft Explorer to navigate to the Time Table (Site) folder on your Web 
server. 

2. In the Biweekly, Daily, Semimonthly, and Weekly folders, rename the webtk.frt and 
webtk.frx files to old_webtk.frt and old_webtk.frx. These files contain the existing 
Timesheet reports. By renaming them, you are saving the original ones to use again 
if desired. 

The screen shot that follows is an example of the renamed files in the Daily folder. 
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3. Use Microsoft Explorer to navigate to the grid folder in the Sema4 directory where 
your Sema4 program files are installed. The default location of the Sema4 program 
directory is C:\Program Files\Deltek\S490\Web\Sample\grid. 

You see a Biweekly, Daily, Semimonthly, and Weekly folder in the grid folder. 

Each of these folders contain the Sema4 9.1 (SP3) webtk.frx and webtk.frt report 
files that contain the new Web Timekeeper reports that display hours worked and 
project/phase/task. 

 
4. Open the Daily folder and copy the webtk.frt and webtk.frx report files. 

5. Navigate to the Daily folder in your Time Table (Site) folder and paste the report 
files. 

6. Repeat these steps to copy and paste the report files from and to the Biweekly, 
Semimonthly, and Weekly folders. 
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